
MicroStation CONNECT - Quickstart    surell consulting ab  

 

      

 

 

 

MicroStation 
CONNECT Edition 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

Quickstart 
Får ej spridas. Endast för kursdeltagare. 



 MicroStation CONNECT - Quickstart     surell consulting ab 

 

      

 

 

  

MicroStation CONNECT - Quickstart, 2024-03-05 

© copyright surell consulting ab, 2021 

 

surell consulting ab 

ringduvevägen 13, 132 47 saltsjö-boo 

e-post: consulting@surell.se, web: www.surell.se 

mailto:consulting@surell.se


MicroStation CONNECT - Quickstart    surell consulting ab  

 

      

 

 

 

 

 

Innehåll 

 
Om kursen ................................................................................................................. 1 

Nya och förändrade funktioner ............................................................................................................ 1 

Termer ....................................................................................................................... 2 

Typografi och konventioner .................................................................................... 3 

Kom igång ................................................................................................................. 4 

CONNECTION Client ........................................................................................................................... 4 

CONNECT Center ............................................................................................................................... 5 

Mina Tjänster ..................................................................................................................................................................... 5 

Starta MicroStation CONNECT ................................................................................ 6 

ProjectWise och WorkSpaces ............................................................................................................................................ 6 

Starta MicroStation .............................................................................................................................. 7 

Välj WorkSet ...................................................................................................................................................................... 8 

Öppna filer direkt .................................................................................................................................. 8 

Skapa WorkSpace och WorkSets ........................................................................................................ 8 

Skapa WorkSpace .............................................................................................................................................................. 9 

Skapa WorkSet .................................................................................................................................................................. 9 

Användargränssnittet............................................................................................. 11 

 ........................................................................................................................................................... 11 

Backstage .......................................................................................................................................... 11 

Öppna, skapa ny .............................................................................................................................................................. 11 

Tools ................................................................................................................................................................................ 11 

Settings ............................................................................................................................................................................ 11 

Print ................................................................................................................................................................................. 12 

Help ................................................................................................................................................................................. 12 

Workflows........................................................................................................................................... 14 

Drawing ............................................................................................................................................................................ 14 

General ............................................................................................................................................................................ 14 



 MicroStation CONNECT - Quickstart     surell consulting ab 

 

      

 

 

Modeling .......................................................................................................................................................................... 14 

Visualization ..................................................................................................................................................................... 14 

Task Navigation ............................................................................................................................................................... 14 

Ribbons, tabs ..................................................................................................................................... 15 

Sökfältet ............................................................................................................................................. 15 

Andra resurser i sökfältet .................................................................................................................................................. 16 

Snabbkommandon ............................................................................................................................. 17 

Mellanslag ........................................................................................................................................................................ 17 

Q ...................................................................................................................................................................................... 18 

Snapplägen ...................................................................................................................................................................... 18 

Aktivera v8i Taskmenyn ................................................................................................................................................... 18 

Positional mapping ........................................................................................................................................................... 19 

Anpassa menyer och verktygsfält ...................................................................................................... 20 

Egna anpassningar ............................................................................................................................ 20 

AccuDraw ................................................................................................................ 22 

Nya kortkommandon .......................................................................................................................... 22 

Övriga användbara kortkommandon ................................................................................................. 22 

Använda Project Explorer ...................................................................................... 23 

Öppna Explorer .................................................................................................................................. 23 

Olika sektioner ................................................................................................................................... 23 

File ................................................................................................................................................................................... 24 

Items ................................................................................................................................................................................ 25 

Resources ........................................................................................................................................................................ 26 

Sheet Index ...................................................................................................................................................................... 27 

Links ................................................................................................................................................................................ 28 

Använd dialogen Properties ............................................................................................................... 28 

Sökningar ........................................................................................................................................... 28 

Mer avancerade sökningar ............................................................................................................................................... 29 

Inställningar ........................................................................................................................................ 31 

Item Types ............................................................................................................... 32 

Skapa ................................................................................................................................................. 32 

Skapa bibliotek ................................................................................................................................................................. 32 

Skapa Item Type .............................................................................................................................................................. 32 

Koppla till element .............................................................................................................................. 33 

Visa och redigera attributinformationen ............................................................................................. 34 



MicroStation CONNECT - Quickstart    surell consulting ab  

 

      

 

 

Exportera och importera Item Types ................................................................................................. 36 

Exportera Item Types ....................................................................................................................................................... 36 

Importera Item Types ....................................................................................................................................................... 36 

Display Rules .......................................................................................................... 39 

Använda Display Rules ...................................................................................................................... 39 

Skapa Display Rules .......................................................................................................................... 39 

Skapa Display Rule .......................................................................................................................................................... 39 

Skapa villkor ..................................................................................................................................................................... 40 

Skapa en Action ............................................................................................................................................................... 41 

Ett exempel ...................................................................................................................................................................... 42 

Rapporter och tabeller ........................................................................................... 44 

Använda rapporter ............................................................................................................................. 44 

Skapa en rapportdefinition ................................................................................................................................................ 44 

Placera i filen .................................................................................................................................................................... 46 

Exportera till Excel ............................................................................................................................................................ 47 

Använda tabeller ................................................................................................................................ 48 

Annotation ............................................................................................................... 51 

Text Favorites .................................................................................................................................... 51 

Skapa en textfavorit .......................................................................................................................................................... 51 

Placera en textfavorit ........................................................................................................................................................ 51 

Styra bakgrundsfärg för textfält ......................................................................................................................................... 52 

Redigera textfavoriter ....................................................................................................................................................... 53 

Labels................................................................................................................................................. 54 

Skapa en labelcell ............................................................................................................................................................ 54 

Placera en labelcell .......................................................................................................................................................... 55 

Skapa ritningar ....................................................................................................... 57 

Vad är Named Boundaries?............................................................................................................... 57 

Olika arbetsflöden .............................................................................................................................. 57 

Drawing Boundary ............................................................................................................................................................ 57 

Enstaka ............................................................................................................................................................................ 58 

Arrayer ............................................................................................................................................................................. 58 

Följ kurva ......................................................................................................................................................................... 59 

Named Boundary dialog ................................................................................................................................................... 60 

Place Named Boundary .................................................................................................................................................... 61 

Delete Named Boundary or Group ................................................................................................................................... 61 



 MicroStation CONNECT - Quickstart     surell consulting ab 

 

      

 

 

Apply ................................................................................................................................................................................ 61 

Create Drawing ................................................................................................................................................................ 61 

Fit to named boundary...................................................................................................................................................... 62 

Copy named boundary ..................................................................................................................................................... 62 

Properties ......................................................................................................................................................................... 62 

Mer information .................................................................................................................................. 63 

Redigera grafiska celler ......................................................................................... 64 

Parametriska solider .............................................................................................. 65 

Parametrisk design ................................................................................................ 67 

Termer................................................................................................................................................ 67 

Variations ......................................................................................................................................................................... 67 

Constraints ....................................................................................................................................................................... 67 

Variabler ........................................................................................................................................................................... 67 

Skapa ett parametriskt objekt ............................................................................................................ 68 

Rita profilen ...................................................................................................................................................................... 68 

Definiera Constraints ........................................................................................................................................................ 69 

Definiera variabler ............................................................................................................................................................ 70 

Skapa Variations .............................................................................................................................................................. 72 

Koppla mått ...................................................................................................................................................................... 72 

Tillämpa Variations ........................................................................................................................................................... 73 

Skapa en Solid ................................................................................................................................................................. 74 

Skapa en parametrisk cell ................................................................................................................................................ 75 

Perforators (Tech preview) .................................................................................... 78 

Skapa en Perforator ........................................................................................................................... 78 

Named Presentations (Tech preview) ................................................................... 81 

Placement Points .................................................................................................... 83 

Använda Bing Maps ............................................................................................... 85 

Välj koordinatsystem .......................................................................................................................... 85 

Slå på Bing Maps ............................................................................................................................... 86 

Map Type ......................................................................................................................................................................... 86 

Elevation Offset ................................................................................................................................................................ 86 

Transparency ................................................................................................................................................................... 86 

GIS (MicroStation 2023) ......................................................................................... 88 

Bing Maps .......................................................................................................................................... 88 

Feature Services ................................................................................................................................ 88 



MicroStation CONNECT - Quickstart    surell consulting ab  

 

      

 

 

Raster Services .................................................................................................................................. 88 

Rasterlinjestilar ....................................................................................................... 89 

Area Tools ............................................................................................................... 90 

Set Element Elevation ............................................................................................ 91 

Importera PDF som element .................................................................................. 92 

Reality Modeling ..................................................................................................... 93 

Context Capture ................................................................................................................................. 93 

Koppla filer ......................................................................................................................................... 93 

LumenRT ................................................................................................................. 95 

Modell i MicroStation .......................................................................................................................... 95 

Modell i LumenRT .............................................................................................................................. 96 

Övriga förändringar ................................................................................................ 97 

Några viktiga nyheter ......................................................................................................................... 97 

Vad har tagits bort? ............................................................................................................................ 97 

 





 

 Om kursen 1 

 

Om kursen 

MicroStation CONNECT (numera MicroStation 2023) är den senaste versionen av MicroStation. 

MicroStation CONNECT är den största versionsuppgraderingen på länge vilket bland annat innebär 

att programmet nu är ett 64-bitars program vilket gör det möjligt att arbeta med betydligt större filer 

och mer komplexa modeller. De största förändringarna har skett kring användargränssnittet men 

mycket arbete har lagts ner på att skapa ett effektivt och flexibelt arbetsflöde. MicroStation CONNECT 

använder samma filformat som MicroStation v8i. Support för import och export av olika filformat (dwg, 

skp med mera) i nya versioner är också en viktig anledning till att använda den senaste versionen av 

MicroStation. 

Sedan 2023 har man gått över till att namnge versionerna efter årtal, till exempel MicroStation 2023. 

Det är dock ingen skillnad i hur programmet ser eller fungerar. 

Syftet med kursen är att hjälpa befintliga användare att snabbt komma i gång med programmet. Fokus 

ligger på att hitta rätt i det nya användargränssnittet men kursen tar även upp många nya funktioner 

och finesser. 

Nya och förändrade funktioner 

I kursen ligger fokus på det nya användargränssnittet och de viktigaste nyheterna. 

För en fullständig lista över nyheter och förändringar hänvisas till avsnittet What´s New i onlinehjälpen 

som finns under File > Help > Help Content. 
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Termer 

I dokumentet används följande begrepp och termer:  

  

MicroStation Ett avancerat 2D/3D CAD-program som används för 

konstruktion, arkitektritning, GIS etc. 

Designfil Den fil som MicroStation lagrar 

ritningen/kartan/konstruktionen i. Kallas även dgn-fil. 

Modell Varje designfil kan innehålla en eller flera ritningar. Varje 

sådan ritning kallas en modell. 

Sheet View En speciell modell avsedd för utskrift. Denna modell är 

oftast skapad i pappersenheter till skillnad från kartorna som 

är i skala 1:1. 

Textstyle Formatmall för text. All text som formaterats med samma 

textstyle kan ändras genom att modifiera motsvarande 

textstyle. 

Dimensionstyle Formatmall för måttsättning. 

Designlib En tom designfil som innehåller mallar för gemensamma 

inställningar som nivåer och textstyles. Kallas även dgnlib. 

Seed-fil En mallfil som används som utgångspunkt när man skapar 

en ny ritning. Olika seed-filer används för 2D och 3D. 

Dataknappen Vänster musknapp. Används för att ge datapunkter och 

välja i menyer. 

Resetknappen Höger musknapp. Används för att avsluta ritkommandon 

och visa anpassade menyer.  

Snappa Förmågan för markören att fästa vid befintliga geometrier 

vid ritning. 

 

  



 

 Typografi och konventioner 3 

 

Typografi och konventioner 

I manualen används olika typer av text för att markera information av skilda slag. 

 

Skärmtext Skärmtext och användarinmatning visas på detta sätt. 

Ex. Skriv ustation för att starta MicroStation. 

<TANGENTER> Alla tangenttryckningar och mustryckningar. 

Ex. Tryck på <ENTER> för att komma till nästa fält. 

[Menyval] Markerar menyval. 

Ex. Välj [Databas - Sökningar] för att arbeta med 

databasinformationen. 

Tryckknappar Detta används för att markera tryckknappar. 

Ex. Tryck på Ok för att avsluta 

Nyckelord Nyckelord visas med kursiv stil. 

Ex. Dessa tecken kallas jokertecken. 

 

Tips eller andra viktiga stycken markeras med kursiv stil 

inom en ram. 
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Kom igång 

MicroStation har fått ett nytt utseende, en annorlunda projekthantering och många nya funktioner. Det 

nya användargränssnittet gör startsträckan kortare eftersom det bygger på det välbekanta Microsoft 

Officemiljön. Den nya projekthanteringen med WorkSpaces och WorkSets är mer flexibel och gör det 

lättare att dela information mellan olika projektgrupper och avdelningar. Med Connected Projects kan 

man dela projektinformation oavsett var i världen projektdeltagarna sitter. 

CONNECTION Client 

CONNECTION Client är ett program som installeras tillsammans med MicroStation CONNECT och 

startas automatiskt varje gång datorn startas. Man måste alltid logga in via CONNECTION Client för 

att kunna köra MicroStation eftersom programmet ersätter den gamla licenshanteringen.  

 

Programmet används även för att ge användaren tillgång till olika Bentleytjänster som den personliga 

portalen, meddelanden, programuppdateringar, kurser och mycket annat.  

För att kunna använda CONNECTION Client måste man ha en inloggning. Har man redan en 

inloggning, till exempel via SELECT kan man använda den annars måste man skapa en inloggning. 

Detta göras ofta via företagets IT-avdelning eftersom inloggningarna är knutna till företagets licenser.  

CONNECTION Client används även av MicroStation V8i SS10 vilket gör det möjligt att dela 

information i projekt som både använder V8i och CONNECT. 
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CONNECT Center 

CONNECT Center är en molntjänst som varje registrerad användare har tillgång till. Via den 

CONNECT Center kan man komma åt gemensamma projekt, kurser, kalender och genvägar till flera 

andra tjänster. 

Man kan komma åt CONNECT Center från CONNECT Client eller direkt från en webbläsare. Sidan 

kan anpassas och uppdateras emellanåt så utseendet kan variera. 

 

Mina Tjänster 

 

Här kommer man åt många användbara resurser. Man kan ladda ner program, hitta dokumentation, 

felrapportera och hitta olika typer av utbildningsmaterial. 
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Starta MicroStation CONNECT 

För att öppna och arbeta med filer måste man förstå hur MicroStation CONNECT hanterar projekt. 

Man kan visserligen arbeta helt utan projektkonfigurationer (No WorkSpace / No WorkSet). Detta görs 

främst när man öppnar enstaka filer som inte är en del av något projekt.  

Det som tidigare var projekt har nu delats upp i två nivåer: WorkSpace och WorkSet. WorkSpace kan 

användas för olika ändamål men motsvarar ofta en avdelning, en förvaltning eller annan logisk enhet. 

WorkSet är olika konfigurationer under respektive WorkSpace och används ofta på samma sätt som 

projekt gjordes tidigare. 

Om man använder ProjectWise kan denna hantering se lite annorlunda ut eftersom man då har 

möjligheten att arbeta med Managed WorkSpaces. Detta innebär att ProjectWise automatiskt skapar 

WorkSpace och Worksets varje gång en fil öppnas från ProjectWise. 

Man kan inte längre använda ucf-filerna (User Configuration Files) för att konfigurera program eller 

andra övergripande inställningar. Dessa är numera endast till för att spara användarspecifika 

inställningar. 

ProjectWise och WorkSpaces 

När man använder ProjectWise finns förutom vanliga WorkSpaces även möjligheten att använda så 

kallade Managed WorkSpaces. Detta innebär att ProjectWise automatiskt skapar ett WorkSpace när 

man hämtar ut en fil. 
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Starta MicroStation 

När man startar MicroStation från startmenyn kommer man till följande skärmbild. 

 

Denna ersätter den gamla dialogen MicroStation Manager som används i MicroStation v8i. 

Till vänster visas de senaste WorkSets som senast har använts. I mitten visas de senaste filerna i det 

senaste WorkSetet. Till höger visas detaljerad information om det aktuella WorkSetet. 

Knappen Browse gör det möjligt att välja valfri fil och knappen New File  skapar en ny fil. 
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Välj WorkSet 

När man ska öppna filer väljer man från vilket WorkSpace och WorkSet detta ska göras. 

 

I exemplet ovan är WorkSpace Example och WorkSet MetroStation. 

När man valt detta kan man välja att öppna önskad fil. 

Öppna filer direkt 

En väldigt bra nyhet i MicroStation CONNECT är filerna numera är kopplade till det WorkSet och 

WorkSpace i vilket dom skapades. Detta gör det möjligt att automatiskt ladda rätt konfiguration om 

man dubbelklickar på en fil för att starta MicroStation. 

Om man väljer att öppna en fil som inte tillhör det aktiva WorkSpacet får man ett meddelande och kan 

välja om man ska aktivera den nya konfigurationen eller fortsätta med det aktiva WorkSpacet. 

 

Skapa WorkSpace och WorkSets 

Man kan skapa både nya WorkSpace och WorkSets. Oftast hanteras detta på en central nivå i 

företaget men här beskrivs kort hur man kan göra för att skapa nya WorkSpaces och WorkSets. 

Om man klickar på WorkSpacemenyn för att välja ett nyy WorkSpace finns även möjligheten att skapa 

nya WorkSpace. 
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Skapa WorkSpace 

 

Klickar man på ikonen Create WorkSpace öppnas en dialog där man får ange namnet på det nya 

WorkSpacet och en eventuell beskrivning. 

 

När detta görs skapas en katalogstruktur och en konfigurationsfil i angivna mappar. 

Var dessa mappar ligger styrs av var företaget har valt att lägga gemensamma resurser. Som 

standard läggs projekten i mappen:  

C:\ProgramData\Bentley\MicroStation CONNECT Edition\Configuration\WorkSpaces 

Skapa WorkSet 

För att skapa ett nytt WorkSet gör man på liknande sätt. 

Klicka på WorkSetmenyn. 
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Även här finns en ikon där man i stället kan välja att skapa ett nytt WorkSet. 

 

Ange ett namn för WorkSetet och en eventuell beskrivning. 

Eftersom detta oftast motsvarar projektnivån kan man även tilldela projektspecifika egenskapar eller 

knyta det till ett ProjectWiseprojekt. 

Man kan ha mallar (Template) för både WorkSpaces och WorkSets. Då kommer alla mappar och filer i 

angiven template kopieras till det nya WorkSpaces/WorkSetet.  
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Användargränssnittet 

 

 

Backstage 

Backstage kallas den del av användargränssnittet som innehåller funktioner som Öppna, Ny fil, 

Inställningar, Verktyg, Utskrifter och många andra funktioner. Hit kommer man om man väljer [File] i 

MicroStations huvudmeny.  

 

 

Öppna, skapa ny 

De senaste filerna för aktuellt WorkSpace visas i listan. Tryck på Browse för att öppna någon annan 

fil. 

Klicka på New för att skapa en ny fil. 

Tools 

Här hittar man verktyg som Compress, License Manager, Batch Converter och Batch Process. 

Settings 

Under Settings finns grupperna User, System, File och Configuration. 
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User innehåller mycket av det som man tidigare hittar under menyn [WorkSpace] bland annat 

Preferences. 

Under System finns möjlighet att sätta upp digitaliseringsbord. 

Under File finns delar av det man tidigare hittade under [Settings] till exempel Design File Settings, 

Color Table, Database Settings och Line Styles Settings. 

Configuration innehåller Configuration Variables, Configuration Migration, Customize och About 

Configuration. 

Print 

Printdialogen. Man kommer även år denna via snabbfältet till höger om menyn Workflow. 

Help 

Här kommer man åt alla hjälpfunktioner och länkar till olika resurser på nätet. 
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Övning 

Använd [File > Settings > User > Customize Ribbon] för att lägga till dialogen Preferences i 

snabbraden (Quick Access Toolbar). Dialogen finns under Commands (Application). 
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Workflows 

Funktionerna i MicroStation CONNECT är indelade i ett antal huvudgrupper, så kallade Workflows. 

Dessa innefattar Drawing, General, Modeling, Visualization och Task Navigation. En 2D-fil har 

Drawing, General och Task Navigation. 

Man växlar mellan dessa worksflows via menyn överst till vänster. 

 

Beroende på vilket workflow man valt kommer olika ribbonmenyer visas. Varje workflow har olika 

grupper. 

Drawing 

 

General 

 

Modeling 

 

Visualization 

 

Task Navigation 

 

I detta workflow motsvarar grupperna de olika Task som fanns i v8i. 

Man kan även plocka fram en Taskmeny med samma utseende som i v8i genom att välja Dialog i 

menyn till höger om Workflow. 
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Ribbons, tabs 

Ribbonmenyerna känns igen från Officeprogrammen och är gjorda för att man enkelt ska hitta olika 

funktioner. Dessa är indelade i olika undermenyer, så kallade Tabs.  

 

Varje tab innehåller funktioner för ett visst ändamål,till exempel View, Annotate, Attach, Analyze.  

Inom varje tab hittar man sedan ytterligare grupper med mer specifika funktioner. 

 

Sökfältet 

Längst upp till höger hittar man en efterlängtad nyhet nämligen sökfältet. 

 

Här kan man hitta och starta funktioner genom att skriva in ett sökord. 
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Genom att klicka på ett sökresultat startar man funktionen eller öppnar dialogboxen. 

Om man dröjer kvar lite över ett sökresultat med markören visas alla ställen i användargränssnittet där 

funktionen kan startas. Detta gör att man kan lära sig var de olika funktionerna finns i menysystemet. 

 

Andra resurser i sökfältet 

Klickar man på frågetecknet finns genvägar till andra resurser.  
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Snabbkommandon 

Många av de kommandona kommer man åt oavsett i vilket workflow man befinner sig genom att 

använda olika snabbkommandon. 

Mellanslag 

Genom att trycka på mellanslag öppnas en popupmeny vid muspekaren. 

 

Denna meny varierar beroende på i viket workflow man befinner sig. 

Klickar man på någon av ikonerna öppnas ytterligare en dialog. Klickar man till exempel på ikon 4 

(Placement) öppnas följande dialog där man kommer åt de flesta placeringsfunktionerna. 

 

Man kan även välja funktioner i dialogboxarna genom att trycka på motsvarande siffra eller bokstav. 

 

Från och med MicroStation 2023 finns även en flik med de senast använda kommandon i 

snabbdialogen som öppnas med Mellanslag. 
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Q 

Trycker man på Q får man upp en annan meny med snabbåtkomst till olika toolboxar och 

kommandon. 

 

Här kan man komma åt många toolboxar och vanliga kommandon genom att klicka eller skriva in 

angiven siffra eller bokstav. Detta är i många fall det snabbaste sättet att start de vanligaste 

kommandona. 

Snapplägen 

Man kan numera öppna ett fönster för att välja snapplägen genom att hålla ner Shift samtidigt som 

man ger en Tentative point, Shift+Tentative. Detta öppnar följande dialog. 

 

Ctrl+Shift+Tentative öppnar den gamla snappmenyn. 

Aktivera v8i Taskmenyn 

Det finns möjlighet att använda ett utseende som påminner om v8i. Hur detta görs har ändrats lite 

mellan versionerna men i Update 15 fungerar det på detta sätt. 

Välj Workflow. Alla workflows utom Task Navigation fungerar på detta sätt. 

Välj sedan Dialog i menyn till höger om Workflow. 

Då öppnas en taskment som ser ut som i v8i. Ribbonmenyn kan minimeras så slipper man se båda 

menyerna. 
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I versioner innan U13 kan detta göras genom att definiera en konfigurationsvariabel. 

Sätt variabeln MS_TASKNAVIGATION_CONFIGURATION = 1. 

Detta kan göras via [File > Settings > Configuration > Configuration Variables]. 

Variabler som skapas här sparas i användarens privata konfigurationsfil (Personal.ucf). 

Vill man dessutom kunna använda de gamla kortkommandona måste man aktivera Positional 

Mapping under Preferences (se nedan). 

Positional mapping 

Positional mapping är den metod för att mappa tangenter till kommandon som användes i 

MicroStation v8i. 

För att aktivera Positional Mapping behöver man göra följande: 

1. Gå till [File > Settings > User > Preferences] 

2. Välj Position Mapping i listan till vänster 

3. Bocka för Use Position Mapping och Show Position Mapping Aids 
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När detta är gjort kommer ikonerna i Ribbonmenyn ha bokstäver kopplade till sig. 

4. Vill man att genvägarna ska fungera (i stort sett) som i v8i ska man även göra följande ändringar: 

5. Växla Workflow till Task Navigation 

eller 

Växla till Drawing > Dialog 

Anpassa menyer och verktygsfält 

Alla menyer, ribbons och toolboxar kan anpassas för att optimera användargränssnittet efter varje 

användare eller företags önskemål. 

För att anpassa någon del av ribboninterfacet högerklickar man på en tom del och väljer [Customize 

Ribbon]. Alla förändringar som görs sparas enbart för den inloggade användaren (se nedan). 

Egna anpassningar 

I MicroStation CONNECT sparas alla anpassningar i användarens personliga mapp. Denna hittar man 

på följande ställe: 

C:\Users\Användare\AppData\Local\Bentley\MicroStation\10.0.0\prefs 

eller för MicroStation 2023 

C:\Users\Användare\AppData\Local\Bentley\MicroStation\23.0.0 

Observera att mappen AppData är en dold mapp och man därför måste visa dolda mappar i 

utforskaren för att se den. 

Man kan också öppna mappen genom att skriva följande i MicroStations kommandofält: 

$ % explorer $(_USTN_HOMEPREFS) 
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I denna mapp finns bland annat följande filer som lagrar olika typer av inställningar. 

 

Personal.ucf Personliga konfigurationsvariabler 

Personal.dgnlib Anpassningar av användargränssnittet 

Personal.funckey.mnu Anpassningar av funktionstangenterna 

Om variabeln MS_FKEYMNU är definierad till en annan meny gäller den. 

 

Här finns även filer som håller ordning på senaste inställningar, dockade fönster och mycket annat. 

Allt innehåll i denna mapp kan raderas om man vill återställa MicroStation till grundinställningarna.  
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AccuDraw 

AccuDraw är precis som tidigare ett av de viktigaste hjälpmedlen för att skapa måttriktiga ritningar. 

Nya kortkommandon 

De flesta genvägar fungerar som tidigare men några kommandon har ändrats för att anpassas de nya 

funktioner som MicroStation CONNECT använder. 

 

Tangent Funktion V8i 

<?> Visar en lista över alla genvägar <?> 

<M> Växlar mellan rektangulärt och polärt 

koordinatsystem 

<Mellanslag> 

<PP> Öppnar Point Keyin Single <P> 

<PM> Öppnar Point Keyin Multiple <M> 

<§> Byter värde för Tool Settings  

 

Övriga användbara kortkommandon 

 

Tangent Funktion 

<Enter> Låser input till X eller Y 

<O> Placerar AccuDraws origo vid muspekaren 

<V> Roterar AccuDraw till vyrotation 

<T> Roterar AccuDraw till topprotation (filens X/Y) 

<F> Roterar AccuDraw till front 

<S> Roterar AccuDraw till sida 

<E> Växlar AccuDraw mellan topp, front, sida 

<RE> Roterar AccuDraw mot elementet under muspekaren 
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Använda Project Explorer 

Project Explorer eller bara Explorer som den numera heter har funnits med sedan v8i men har fått mer 

funktioner och är ofta lite förbisedd. I Explorer finns all information om filen samlad på ett och samma 

ställe och man kommer enkelt åt modeller, referenser, lager, linjestilar, Item Types och mycket annat 

som rör filen. Man kan också söka efter element, texter och attribut. 

Öppna Explorer 

Öppna Explorer genom att klicka på ikonen Explorer i ribbonmenyn [[Drawing] > Primary]. 

 

Då öppnas dialogen Explorer. 

 

Olika sektioner 

Explorerdialogen är indelad i sektioner som innehåller information om olika aspekter av filen. 
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File 

 

Under sektionen File finns allt filinnehåll som element, modeller, referenfiler, rapporter, lager mm. 

Genom att högerklicka på olika delar kan man byta modeller, öppna referensfiler. 
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Items 

 

Under sektionen Items hittar man de Item Types som finns i filen. Genom att använda sökfunktionen 

kan man hitta element genom att söka på olika attributvärden. 
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Resources 

 

Under sektionen Resources hittar man resurser som finns tillgängliga via dgnlibs, linjestilar, fonter och 

andra externa filer som MicroStation hittar via konfigurationsvaiabler. 
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Sheet Index 

 

Under sektionen Sheet Index finns alla ritningar som indexerats i filen. 
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Links 

 

Under sektionen Links listas alla länkar som definierats. Detta kan vara länkar till websidor, andra 

dokument eller objekt i filen. 

Använd dialogen Properties 

Om man har dialogen Properties öppen får man ofta en väldigt bra överblick över alla egenskaper 

som är kopplade till det aktuellaobjektet. Testa till exempel att välja ett lager under Files – Levels och 

se vad som visas i Properties. 

Sökningar 

I sektionerna File, Items och Resources finns möjlighet att söka information. 
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Här kan man skriva in valfri text för att söka efter text oavsett var den finns. I exemplet sökte vi efter 

ett textelement i filen. Eftersom det fanns ett textelement med denna text visas detta i sökresultatet 

och läggas in i ett Selection Set. 

 

Observera att man endast kan söka efter text på detta sätt. Vill man söka efter numeriska värden som 

ID-nummer måste man använda avancerade eller utökade sökningar (se nedan). 

Om man dessutom klickar i ikonen Zoom  ovanför sökrutan kommer texten att zoomas in. Man 

kan även välja Isolate  för att släcka allt annat eller göra elementen i vyn transparenta genom att 

klicka på ikonen Transparent  vilket kan vara bra om man har en 3D-modell. 

Man kan även söka efter modellnamn, attributvärden eller vilken annan information som helst i filen 

som kan beskrivas med en text. 

Mer avancerade sökningar 

Om man vill söka efter numeriska värden eller ange ett specifikt attribut måste man använda utökade 

sökningar eller avancerade sökningar. 

Utökade sökningar 

Utökade sökningar gör det möjligt att söka efter specifika attribut.  

Om man klickar på ikonen längst till höger om sökfältet kan man välja vilket attribut man ska söka i. I 

detta läge kan man även söka efter numeriska värden. 
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I exemplet har man angett att man endast ska söka på attributet RIKSNYCKEL. 

 

Avancerade sökningar 

Genom att använda avancerade sökningar kan man söka på flera attribut samtidigt. Om man klickar 

på förstoringsglaset till höger om sökfältet öppnas en dialogbox där man kan ange flera sökkriterier. 
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I detta exempel har man valt att söka efter ledningar som har gatunamnet BOKVÄGEN och 

innerdiameter 150. 

Inställningar 

Man kan anpassa innehållet i dialogen Explorer. För att göra detta väljer man [File > User > Explorer 

Settings] från menyn i MicroStation. 

Övning 

Öppna filen Explorer.dgn. 

Sök efter textelementet Tibastvägen. Se till att MicroStation zoomar in kring sökresultatet. 

Sök efter byggnaden som har IDNR=555. 

Öppna filen Husmodell_3D.dgn. 

Lokalisera alla dörrar genom att göra modellen transparent. 

Byt till modellen VA via Explorer 
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Item Types 

Item Types används för att beskriva ett objekts egenskaper. Dessa egenskaper kan vara kopplade till 

element och bildar då ett objekt som beskriver både geometri och attributegenskaper. Man kan skapa 

Item Types som motsvarar en dörr, en brunn, en ledning eller vilket annat objekt som helst. Denna har 

sedan olika egenskaper. Detta kan till exempel vara material, pris, fabrikat, ägare, status, 

inspektionsdatum. När man sedan kopplat egenskaper (Item Type) till elementen i modellen kan man 

använda dessa för att söka objekt, skapa rapporter och tabeller baserade på dessa egenskaper. 

Item Types kan skapas av användaren direkt i en fil men skapas oftare automatiskt av olika 

programvaror eller är kopplade till celler i cellbibliotek. Detta används av många BIM och GIS-

program. 

Skapa 

Item Types skapas med dialogboxen Item Types som öppnas genom att klicka på den lilla ikonen i 

höger nederkant av gruppen Itiem Types. 

 

 

Här kan man skapa Item Types som kan grupperas ihop i olika bibliotek (Libraries). 

Skapa bibliotek 

Ett bibliotek (Library) används för att spara en grupp av Item Types. Man kan ha olika bibliotek för 

arkitektur, järnväginformation eller en baskarta. 

Skapa Item Type 

I ett bibliotek kan man sedan skapa en Item Type. Detta kan till exempel vara en dörr. Man skapar en 

ny Item Type genom att klicka på ikonen New Item Type. Ge ett beskrivande namn för den nya typen. 

I detta fall ”Dörr”. 
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När man skapat en Item Type ska man lägga till olika egenskaper. Detta gör man genom att lägga till 

en Property Definition. Klicka på ikonen New Property Definition. 

 

I exemplet har vi lagt till egenskaperna ID, Fabrikat, Höjd och Bredd. I praktiken har objekten ofta 

många fler egenskaper. 

Man kan ange att en egenskap ska vara text, integer, flyttal, datum eller en punkt och även ange 

defaultvärde eller ett uttryck (Expression). 

Koppla till element 

För att koppla en Item Type till ett element används kommandot Attach Item som finns under 

ribbonmenyn [[Drawing] > Attach > Item Types]. 
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Välj önskad Item Type i listan, fyll i informationen och peka sedan på det element som informationen 

ska knytas till. 

Visa och redigera attributinformationen 

För att granska och redigera attributinformationen för ett objekt använder man dialogen Properties. 

 

 

Om man i stället vill visa och redigera information för flera objekt samtidigt kan man använda dialogen 

Explorer. Den hittar man under fliken Home. 
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I dialogen Explorer väljer man fliken Items. Där ser man alla Item Types som finns i modellen. 

Högerklicka på önskad Item Type och välj Details för att öppna en tabell med alla instanser av denna 

Item Type. 

 

I tabellen kan man sortera, filtrera, söka och redigera information. När man markerar en rad i tabellen 

kommer motsvarande element att markeras i modellen.  

Om man högerklickar på en rad visa en meny där man bland annat kan zooma och isolera ett objekt. 
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Markerade rader kan också kopieras till andra program för rapportering och analys. 

Item Types kommer att följa med om filen publiceras till en i-model. 

Exportera och importera Item Types 

Om man behöver redigera information för många objekt kan det ibland vara lättare att göra detta i 

Excel där man enkelt kan ersätta värden, skapa sekvenser och mycket annat. Detta kan man göra 

genom att exportera alla attribut, redigera och sedan importera den nya informationen till filen igen. 

 

Exportera Item Types 

Man kan välja att exportera alla instanser (ikonen Instance) eller endast definitionen (ikonen 

Definition). I detta fall vill man exportera attributen för alla instanser (element) så den första ikonen ska 

markeras. 

 

Klicka sedan i Export och välj en mapp för exporten. Klicka på Export . 

Det kommer att skapas en Excelfil för varje Item Type bibliotek. 

Nu kan man använda Excel för att redigera informationen. Observera att man endast kan redigera 

information. Inte lägga till eller ta bort rader! 

Importera Item Types 

När informationen har redigerats kan man importera filen och uppdatera attributinformationen i filen. 
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Klicka för ikonen Instance, bocka i Import, välj fil och klicka på Import . 

Om allt gått bra kommer informationen i filen att uppdateras. 

  

Tomma värden (till exempel datum) kan orsaka problem vid import trots att dom var tomma vid 

exporten. Detta beteende konstaterades i CE U13 men kan komma att ändras i kommande 

versioner. 
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Övning 

Öppna filen Item Types övning.dgn. 

Skapa ett nytt Item Typebibliotek kallat Byggnad. 

Skapa en Item Type kallad Dörr. 

Skapa några olika attribut för dörren, t.ex. ID, Bredd, Material, Ljudklass, Hängning, Färg. 

Anslut denna Item Type till alla dörrar i filen och sätt relevanta attributvärden. 
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Display Rules 

Display Rules är en ny funktionalitet som ger användaren möjlighet att tematisera innehållet i 

modellen baserat på olika egenskaper. Dessa egenskaper kan vara elementegenskaper, attribut eller 

olika fil- eller modellegenskaper. Man kan till exempel visa alla ytor som har en area större än ett visst 

gränsvärde i avvikande färg, eller markera alla element som är kortare än en viss längd. Det som gör 

detta extra intressant är att man även kan använda textattribut (Item Types) för att styra utseendet på 

elementen. 

Fler och fler MicroStationprogram använder Item Types för att spara egenskaper som är knutet till 

geometrin. Dessa kan skapas direkt i filen eller anslutas när geometrierna läses från olika typer av 

datakällor. I BIM och GIS-världen är dessa attributegenskaper grundläggande och MicroStation 

CONNECT ger användare möjlighet att utnyttja denna attributinformation i många olika sammanhang. 

Display Rules förändrar inte informationen i filen utan används endast för display. Man kan dock 

skriva ut och spara PDF-filer med det uppdaterade utseendet. 

Använda Display Rules 

Display Rules kan användas självständigt eller kopplas till en Display Styles.  

I gruppen View kan man tillämpa Display Styles direkt i en eller flera vyer. 

 

 

Välj önskad Display Style och klicka i önskad vy. Är Apply to All Views förbockad kommer samtliga 

vyer att påverkas. 

Vill man kan man i stället koppla en Display Rule till en Display Style. Detta gör man genom att 

redigera önskad Display Style. 

Skapa Display Rules 

Skapa Display Rule 

Display Rules kan skapas via kommandot Apply Display Rule eller från dialogen Display Styles. Vi 

använder dialogen Apply Display Rule. Klicka på de tre prickarna till höger om listan. 
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Då öppnas en dialog där man kan skapa regler för hur informationen i filen ska visas. 

 

 

Ge den nya regeln ett namn. 

Skapa villkor 

Klicka på ikonen New för att skapa en ny regel. Detta skapar en ny rad i listan. Klicka på texten 

Applies always. 

En ny dialog öppnas där man börjar med att sätta ett lämpligt namn. I exemplet har jag skapat en 

regel som heter Skogskant. 

 

När detta är gjort ska man definiera ett urval. Här kan man välja olika element, fil och 
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modellegenskaper och sedan ange vilket värde dessa ska ha. Klicka på listan Pick Property… för att 

välja önskad egenskap. 

Nu visas en lista där man kan välja olika typer av egenskaper. I exemplet har man valt 

elementegenskaper (ELEMENT) och därefter det attribut man vill filtrera på. Denna typ av textattribut 

(Item Types) visas bara om sådana finns kopplade till elementet. 

När man valt egenskap anger man sedan vad denna egenskap ska ha för värde. I detta fall ska 

villkoret ELEMENT.BAS_AGOSLAG_L.OBJEKTTYP = Skogskant vara uppfyllt. 

Stäng dialogboxen. 

När detta är gjort bestämmer man vad som ska hända med de element som uppfyller villkoret. 

Skapa en Action 

Klicka på plustecknet under kolumnen Action (för ett nytt villkor visas endast plustecknet).  

 

 

 

Där kan man välja vad som ska hända när villkoret är uppfyllt. I exemplet har vi valt Symbology 

Overrides. 

 

 

När man väljer Symbology Override visas en meny där man kan ändra olika elementegenskaper. 

 



 

  42 Display Rules  

 

 

 
Här har vi valt att sätta färg, linjestil och linjetjocklek. 

Stegen ovan upprepas för alla regler man vill definiera. 

Ett exempel 

Nedan visas skillnaden i utseende mellan en karta helt utan formatering och när man sedan aktiverat 
en Display Style som är kopplad till en Display Rule. I detta fall utnyttjas attributet objekttyp för att 
sätta olika symbologi på elementen. 

 

Det finns många olika användningsområden för Display Rules. Man behöver inte heller skapa en ny 
Display Style utan kan temporärt aktivera olika Display Rules för att analysera och framhäva 
geometrier med önskade egenskaper. Här är några tänkbara användarfall: 

• Yta större än xxx 

• Element kortare än xxx 

• Visa alla celler 

• Markera alla geometrier som ligger i en referensfil 

• Markera alla geometrier som har textattributet STATUS=Felrapporterad 

• Markera alla geometrier som har textattributet DIMENSION>0.75 

• Osv 

Detta gör det möjligt att skapa många olika slutprodukter från samma ritning och göra analyser 
baserade på olika attributvärden. 
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Man kan även spara Display Rules i dgnlibs så de alltid finns tillgängliga när man arbetar. 

Övning 

Öppna filen Display Rules Baskarta.dgn. 

Aktivera olika Display Rules (Baskarta, Naturobjekt, Stora hus). 

Skapa en ny Display Rule som visar alla kontorsbyggnader i rött, allt annat i grått. 

Använd Item Type BAS_3D_BYGG_KONSTRUKTIONER_L och attributet Byggtyp. 
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Rapporter och tabeller 

Rapportverktygen i MicroStation CONNECT gör det möjligt att hämta attributinformation från objekten i 

filen och presentera dessa i form av rapporter och tabeller. Olika sökvillkor och filter kan användas för 

att hämta olika typer av information. Man kan skapa rapporter baserade på grafiska egenskaper som 

area, lager och modellegenskaper eller använda attribut (Item Types). Rapporter kan användas för 

analys, innehållsförteckningar, stycklistor, kvalitetskontroll och mycket annat. 

Rapporterna kan sparas till Excel, kommaseparerade textfiler eller placeras som tabeller i designfilen. 

Använda rapporter 

Skapa en rapportdefinition 

För att skapa en rapport startar man rapportverktyget under fliken Analyze. 

 

Rapportverktyget använder rapportdefinitioner för att skapa rapporter vilka grupperas i kategorier. 

Klicka på rapportikonen för att skapa en rapport.  

Skapa först en ny rapportkategori och sedan en rapportdefinition. 

Börja med att ange var informationen ska hämtas från och vilka egenskaper som ska inkluderas. 
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I exemplet skapas rapporten från informationen i den aktiva modellen i den aktiva filen och Item Type 

BYGGNAD. 

När detta är gjort talar man om vilka kolumner (attribut) som ska vara med i rapporten.  

 

Expandera rapporten och klicka på Add columns. 

 

Välj de kolumner som ska vara med i rapporten och klicka på OK. 
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Dra kolumnerna i den ordning dom ska visas i tabellen. 

För vissa kolumnstyper kan man ange formatering för att ytterligare kontrollera utseendet på 

rapporten. 

Slutligen kan man förhandsgranska rapporten för att kontrollera att rapportdefinitionen är korrekt. 

 

Om allt ser bra ut kan man exportera rapporten till Excel eller csv eller placera den som en tabell i 

designfilen. 

Placera i filen 

För att placera en rapport i filen klickar man på ikonen Place as Table. 
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Är en rapport markerad i dialogboxen kommer den att visas vid muspekaren och man kan placera ut 

den på önskad plats i filen. 

 

Utseendet kommer att styras av den angivna textstilen (Text Style). 

I Tool Settings kan man även välja att placera en tom tabell eller tabell från en Excelfil. 

Exportera till Excel 

För att exportera en rapport till Excel eller en csv-fil klickar man på ikonen Export results och väljer 

önskat exportformat. 
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Använda tabeller 

Tabeller är en egen elementtyp och har flera olika egenskaper som kan redigeras via dialogen 

Properties. 

När en tabell markeras får den en markering i form av rader och kolumner och tabellens egenskaper 

visas i dialogen Properties. 

 

Om en rad eller kolumn i tabellen markeras visas motsvarande egenskaper i dialogen och kan 

redigeras. 
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Genom att använda Text Styles och justera tabellegenskaper kan man formatera tabellerna på en 

mängd sätt. 

 

Context Ribbon 

När tabellens markeras ändras också ribbonmenyerna. Detta kallas Context Ribbons eftersom de 

anpassas efter markerade objekt. 
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Övning 

Öppna filen Husmodell 3D.dgn. 

Skapa en rapport för Item Type Dörrar. 

Ta med alla attribut. 

Kontrollera resultatet. 

Pröva att gruppera på olika attribut. 
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Annotation 

Med annotering avses här när man placerar text som hämtar sitt värde från någon egenskap hos ett 

element, modell eller en fil. Man kan till exempel placera en text som anger area av en yta eller 

längden på en linje. 

Man har även tidigare kunnat göra detta genom att använda Text Fields men här ska vi fokusera på 

hur man kan spara textfavoriter och hämta värdet från olika elementattribut. 

Text Favorites 

Text Favorites är sparade texter som enkelt kan aktiveras när man ska placera text. 

Skapa en textfavorit 

För att skapa en textfavorit skriver man först önskad text i texteditorn. Vill man använda attribut lägger 

man till ett textfält  (Insert Field) och väljer önskad egenskap. Man kan lägga till flera textfält och 

blanda dessa med vanlig text för att skapa längre texter över flera rader. 

Markera sedan texten, högerklicka och välj Save Text Favorite. 

Placera en textfavorit 

För att placera textfavoriter klickar man på ikonen Insert Favorite och väljer önskad text. 

 

Den sparade texten aktiveras och man kan placera den i ritningen. 

För att placera text som innehåller ett textfält måste ikonen Relative Association vara aktiverad för att 

man ska kunna identifiera ett element innan texten placeras. 

 

Om ikonen är grå och inte kan aktiveras måste man först slå på Association Lock på statusraden. 
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När detta är gjort och man väljer en textfavorit får man först identifiera ett element med dataknappen 

och sedan placera ut texten med ytterligare ett klick med dataknappen. Värdet för textfältet hämtas då 

från det identifierade elementet. 

 

Det är möjligt att ha flera textfält i samma textfavorit. 

Styra bakgrundsfärg för textfält 

Normalt har textfält en grå bakgrund. I de senare versionerna av MicroStation CONNECT kan man 

enkelt styra om textfält ska ha en bakgrundsfärg eller inte. Öppna dialogen View Attributes och 

avmarkera Text Field Background. 

 

Om man använder en Text Style för att sätta en bakgrundsfärg måste Text Field background vara 

ibockad och Use Text Style Background Color for Field Background i Preferences måste också vara 

förbockat. 
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Redigera textfavoriter 

Man kan skapa och redigera textfavoriter med Text Favorite Manager som man öppnar genom att 

välja Manage… under ikonen Insert Favorite. 

 

Då öppnas följande dialogbox. 
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Här kan man lägga till, ta bort och redigera textfavoriter och även redigera namnet som visas i listan. 

Labels 

Labels påminner om textfavoriter men är istället celler som kan innehålla textfält som fylls i vid 

placering. Kommandot Place Label finns i ribbonmenyn [[Drawing] Annotate > Notes]. 

 

Skapa en labelcell 

Skapa först texten på det sätt som beskrivs under avsnittet Skapa en textfavorit och placera den i 

filen. Man behöver inte göra sista steget, Save Text Favorite. 

 

Lägg sedan till eventuell grafik som ska ingå i cellen. 
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Skapa sedan en cell av detta i önskat cellbibliotek. Använd dialogen Cell Library för att lägga till cellen 

i önskat cellbibliotek. Glöm inte att man måste placera cellorigo (Define Cell Origin) och lägga ett 

fence runt elementen innan ikonen Create.. blir aktiv. 

 

Placera en labelcell 

När cellen är skapad kan man placera den med kommandot Place Label. 

 

Se till att ikonen Enable to create relative association to elements är markerad. 
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Klicka på ett element som har de önskade attributen med dataknappen. 

Placera ut cellen på önskad position. 

 

Texten i cellen kommer nu att hämta attributvärdet från det identifierade elementet. 

Övningar 

Öppna filen Annotations.dgn. 

Skapa en label som innehåller VABAS_NR från Item Type DAG_DAGVATTENBRUNN. 

Lägg gärna till någon form av grafik och skapa en cell i cellbiblioteket CE_Quickstart.cel. 

Använd kommandot Place Label för att placera några brunnsbeteckningar. 

Pröva att använda Modify Element för att flytta pilen till en annan brunn. Uppdateras texten? 
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Skapa ritningar 

Utskrifter fungerar till största delen precis som tidigare. Av de nyheter som tillkommit är kanske 

Named Boundaries det som kan spara mest tid och resurser. 

Vad är Named Boundaries? 

Named Boundaries gör det möjligt att snabbt och enkelt skapa flera utskrifter från en modell genom att 

placera ut namngivna områdesmarkeringar (Named Boundaries) som sedan används för att skapa 

utskrifter. Dessa markeringar sparas som Saved Fences i filen. Man kan skapa dessa markeringar 

som enstaka markeringar, arrayer eller längs kurvor.  

Dialogen Place Named Boundaries öppnas från [[Drawing] > View > Place Named Boundary]. 

 

Olika arbetsflöden 

Det finns olika sätt att skapa Named Boundaries. 

Man ska först skapa en områdesmarkering. Detta kan göras via Drawing Boundaries, befintliga 

element eller genom att rita en valfri markering (rektangel, shape eller längd). 

 

Drawing Boundary 

Drawing Boundaries är fördefinierade utsnitt som sparats som en del av en ritningsram. Dessa lagras 

som Sheet Views i ett dgnlib. Det finns ett antal fördefinierade Drawing Boundaries men man kan 

även skapa egna. I övningsprojektet lagras dessa i .Dgnlib\DrawingSeedKurs.dgnlib. 

Innan man börjar är det lämpligt att aktivera ett lager reserverat för att placera 

områdesmarkeringar. 
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Varje Named Boundary har ett namn. Under Name: ange ett namn som beskriver utsnitten. 

Om man valt att placera området via Drawing Boundary får man även ange i vilken skala området ska 

placeras. Vilken skala man anger beror på i vilken skala vald Drawing Boundary är skapad. Är den 

skapad i papperstorlek anges t.ex 1:1000. 

När man valt hur man vill definiera sin Drawing Boundary och angett ett namn ska man välja hur den 

ska placeras i filen. 

Skapa ritningar automatisk 

Vill man skapa ritningar (Sheet Models) automatiskt från områdesmarkeringarna bockar man för 

Create Drawing. Se avsnittet Create Drawing för detaljer kring detta. 

Enstaka 

Placerar en enstaka Named Boundary. 

 

Arrayer 

Placerar en array av Named Boundaries. 
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När man placerar flera områden via Array eller Curve tilldelas dessa en grupp som kan tilldelas ett 

namn. Detta är en grupp av Named Boundaries (tidigare Named Fences) som man kan komma åt 

genom att klicka på den lilla ikonen i nederkant av gruppen (se nedan). 

Här kan man även ange om och hur mycket områden ska överlappa. I exemplet ligger områdena kant 

i kant. 

 

Följ kurva 

I detta fall placeras områdena längs en fördefinierad kurva. 

Även här kan man ange ett gruppnamn och hur mycket angränsande områden ska överlappa. 
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Named Boundary dialog 

När man skapat en eller flera Named Boundaries listas dessa i dialogen Named Boundaries. Har man 

angivit en grupp visas denna och de ingående områdena. Dialogen öppnas genom att klicka på den 

lilla ikonen nederst till höger i gruppen Named Boundaries. 

 

 

 

I denna dialog kan man utnyttja de listade områdena för att zoom, klippa, maska och skapa 

dynamiska vyer inklusive sparade vyer. 

När ett område markeras i listan aktiveras ikonerna. 
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Place Named Boundary 

Öppnar dialogen Place Named Boundary som beskrevs i föregående stycken. 

Delete Named Boundary or Group 

Raderar markerade områden eller grupper. 

Apply 

Använder markerat område för att: 

• Skapa en klippvolym 

• Skapa ett fence 

• Skapa en klippmask 

Endast ett område kan markeras för att använda detta kommando. Väljer man ett nytt område ersätts 

det befintliga med resultatet av det nya. 

Create Drawing 

Öppnar dialogen Create Drawing. 

Denna funktion kan användas inom flera områden. 
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Här kan man skapa Drawing models, Sheet models och sparade vyer från de markerade områdena. 

Vill man endast skapa sparade vyer bockar man ur både Create Drawing Model och Create Sheet 

Model. 

Beroende på vilken Drawing Seed som valts kommer olika delar av dialogen vara aktiverade. 

Fit to named boundary 

Zoomar in kring det markerade området. 

Copy named boundary 

Gör en kopia av det markerade området som kan placeras på ett nytt ställe i filen. 

Properties 

Visar egenskaperna för det markerade området i dialogen Properties. Ikonen är bara aktiv när ett 

enstaka område är valt men visar egenskaperna för alla områden som markeras efter detta. 
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Mer information 

Att arbeta med Named Boundaries och att konfigurera detta korrekt är inte helt enkelt. En bra 

genomgång finns i dessa bloginlägg: 

Blog 1 

Blog 2 

Blog 3 

 
  

https://communities.bentley.com/products/microstation/b/microstation_blog/posts/composing-drawings-blog-series-drawing-boundaries-and-named-boundaries---blog-1-of-3
https://communities.bentley.com/products/microstation/b/microstation_blog/posts/composing-drawings-blog-series-drawing-boundaries-named-boundaries-and-fields---blog-2-of-3
https://communities.bentley.com/products/microstation/b/microstation_blog/posts/composing-drawings-blog-series-drawing-boundaries-named-boundaries-and-fields---blog-3-of-3
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Redigera grafiska celler 

Från och med MicroStation CONNECT Update 17.2 kan man redigera placerade celler. Cellerna 

måste vara Graphical eller Shared Cells, inte Point Cells. 

Högerklicka och håll över en cell. 

Välj Edit Graphical Cell (eller Edit Shared Cell) 

 

Gör önskade redigeringar 

Högerklicka och håll och välj Deactive Cell Editing. 

 

Om det är en grafisk cell kommer endast den valda cellen kommer att uppdateras, är det en shared 

cell uppdateras alla instanser. 
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Parametriska solider 

MicroStation CONNECT använder som standard parametriska solider för all solidhantering. I 

MicroStation v8i fanns både Smart Solids och Feature Solids. Parametriska solider fungerar ungefär 

som Feature Solids, det vill säga man modifierar sin solid med olika features som kan redigeras i 

efterhand. 

Solidverktygen hittar man under [[Modeling] > Solids]. 

 

 

I exemplet har man först skapat en cirkel som sedan extruderats till en cylinder, som fått en rundning, 

som fått ett hål som har gjorts till en array. 

 

Man kan nu ändra alla dessa parametrar, till exempel radien på hålen. 
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Parametrisk design 

Parametrisk design innebär i korthet att objekten har inbyggda regler som kan styra utseende och 

storlek. Man har alltså möjlighet att skapa smarta byggklossar som kan förändra storlek och form 

enligt förutbestämda regler. Detta kan tillämpas på enstaka element i en modell och på celler. 

Vanligast är att man använder detta för att skapa parametriska celler. Detta gör att man i stället för att 

skapa en mängd celler för alla tänkbara variationer av ett objekt, istället skapar en parametrisk cell där 

bestämda egenskaper kan justeras när cellen placeras. 

I detta kapitel ska vi fokusera på hur man skapar en parametrisk cell. Man kan även skapa fristående 

parametriska objekt och förfarandet är exakt detsamma. 

Termer 

Variations 

Variations är sparade variationer av en parametrisk cell. Man kan se dessa som färdiga grupper av 

mått som man ger ett namn. Man kan till exempel ha Variations som motsvarar olika dimensioner för 

en dörr, B70, B80 och B90. För varje Variation anger man vilka mått och värden de ingående 

parametrar ska ha vilket gör det enkelt att placera ut de vanligaste varianterna av ett objekt.  

Vill man inte använda färdiga Variations kan man justera de ingående parametrarna manuellt, både 

innan och efter placering. 

Constraints 

När man bygger upp ett parametriskt objekt måste man ange hur de olika geometrierna och dess 

delar förhåller sig till varandra. Vill man till exempel skapa man en rektangel måste de motstående 

sidorna vara parallella och hörnen vinkelräta. Dessa begränsningar styr hur geometrin kan modifieras 

och kallas Contraints. Vi kommer att titta på hur man skapar en 2D profil för att sedan konvertera den 

till ett parametriskt 3D-objekt.  

Följande funktioner finns för att skapa Constraints: 

 

Variabler 

Syftet med en parametrisk cell (eller objekt) är att kunna skapa olika varianter av objektet där vissa 

egenskaper förändras. För att kunna göra detta använder man variabler. 



 

  68 Parametrisk design  

 

 

I exemplet visas variabler för att styra utseendet på en 3D-dörr. Detta innefattar höjd och bredd på 

dörren, foder och karm. Även väggens tjocklek kan varieras. 

Skapa ett parametriskt objekt 

I följande stycken ska vi se hur man kan skapa en parametrisk cell. Vi kommer först skapa en enkel 

profil och sedan gå vidare hela vägen till en parametrisk 3D-cell. 

Rita profilen 

Börja med att rita en 2D-profil. Vi gör detta i en 3D-modell för att senare kunna omvandla den till en 

3D-solid. Vi kommer att skapa en väldigt enkel dörr. 

I exemplet är dörren skapad med måtten Bredd=900 mm, Höjd=2100 mm. 
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Definiera Constraints 

Nu ska vi bestämma hur denna geometri ska kunna modifieras och måste då sätta ett antal 

Constraints. Det kan vara många olika begränsningar som ska definieras beroende på hur komplex 

geometrin är. Det enklaste sättet är att använda kommandot Auto Constrain. 

 

 

När man använder denna funktion kontrolleras alla ingående segment och elementet får automatiskt 

lämpliga constraints. 
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Symbolerna visar vilken typ av constraint som ansatts de olika delarna. I exemplet har de parallella 

sidorna tilldelats Parallel Constraints och ena hörnet en Perpendicular Constraint. Symbolerna 

motsvarar de olika ikonerna i gruppen Constraints. 

Definiera variabler 

Vi ska nu definiera de olika variabler som behövs för att kunna variera storleken på dörren (man hade 

kunnat gjort det redan innan dörren ritats). Om vi vill kunna variera både bredd och höjd måste vi ha 

variabler för detta. Vi skapar dessa i dialogen Variables som öppnas från [[Drawing] > Constraints > 

Dimensional]. 
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Börjar med att skapa variabler för bredd och höjd. Markera Variables och klicka på ikonen New. 

 

För varje variabel kan man ange Type, Scope, Display, Expression och Active Value. 

 

Type Type anger vilken typ variabeln har. Giltiga 

värden är: 

Distance, Angle, Number, Integer, True/False, 

Area 

Distance, Angle och Area använder filens 

enheter.  

Number och Integer är enhetslösa,  

True/False kan användas för att styra olika 

villkor. 

Scope Scope anger om variabeln ska kunna redigeras 

vid, eller efter placering. 

Instance betyder att variabeln kan redigeras för 

varje instans av objektet. 

Definition betyder att variabeln bara används i 

definitionen och inte kan redigeras. 

Display Detta anger om variabeln ska vara synlig i 

dialogen Properties när objektet placeras som 

en parametrisk cell. Om variabeln endast 

används för interna beräkningar eller är en 

konstant, sätts den lämpligen till Hidden, annars 

till Visible. 

Expression I detta fält kan man ange en formel för en 

variabel. Variabeln X kan t.ex. vara Y / 2.5. 

Active Value Detta anger ett initialvärde för variabeln. 

Om en uttrycket har ett expression kan detta fält 

inte redigeras utan visar resultatet av formeln. 
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Skapa Variations 

I samma dialogbox kan man skapa olika varianter (Variations). Detta innebär att man skapa en eller 

flera namngivna varianter där varje variant har specifika variabelvärden. 

I detta fall ska vi ska tre olika dörrbredder, B70, B80 och B90. Detta gör man genom att skapa tre 

Variations. 

Markera Variation och klicka på ikonen New. 

Skapa tre Variations som heter B70, B80 och B90. 

Ange bredd till respektive 700, 800 och 900. 

 

Nu är vi redo att koppla måtten till dörren. 

Koppla mått 

För att koppla måtten till dörren används funktionerna under [[Drawing] > Constraints > Dimensional]. 

 

Använd funktionen By Element.  

Peka på den övre kortsidan. Det aktuella måttet kommer att visas. När man accepterar visas en lista 

med variabler tillsammans med det aktuella måttet. Vill man låsa till aktuellt mått väljer man detta. I 

detta fall väljer vi Bredd och accepterar. 

Upprepa samma sak för vänster långsida. 



 

 Parametrisk design 73 

 

 

Vi behöver inte koppla de två övriga sidorna eftersom våra constraints säger att sidorna ska vara 

parallella och ha en rät vinkel. 

Tillämpa Variations 

Nu kan vi ändra måtten på dörren genom att använda olika Variations. 

Öppna dialogen Variables och markera önskad Variation. 

Klicka på ikonen Apply variable values to model. 

Dörren uppdateras. 
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Variations ger oss en snabb genväg till olika mått men eftersom vi inte låst vare sig höjd eller bredd 

kan vi även ändra dessa värden via dialogen Properties. 

 

Skapa en Solid 

Nu när vi ser att allt fungerar kan vi gå vidare och skapa 3D-geometri av profilen. 

Byt till Modeling > Solids > Create Solids. 

Här kan vi antingen använda Extrude eller Thicken för att sätta en tjocklek på dörren. I detta fall 

använder vi kommandot Thicken. 

 

Ange Direction: Both och Thickness: 20 och identifiera profilen. 

Man hade kunnat definiera en variabel för dörrtjockleken. Då kan välja variabel genom att klicka på (x) 

till höger på raden Thickness. I detta fall sätter vi istället en fix tjocklek. 
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Nu kan man ändra storleken på denna 3D-dörr på samma sätt som för 2D-profilen genom att använda 

dialogen Variables. 

Skapa en parametrisk cell 

Nu är allt klart för att skapa en parametrisk cell. Eftersom cellbibliotek är vanliga designfiler behöver vi 

bara kontrollera att den aktiva modellen går att placera som en cell. 

Gå till [[Drawing] > Home > Primary] och klicka på ikonen Models. 

Klicka på ikonen Edit Model Properties. 

Se till att egenskapen Can be placed as Cell är satt till True och att Cell Type är Parametric. 



 

  76 Parametrisk design  

 

 

Nu kan denna fil anslutas som ett cellbibliotek. 

I vanliga fall döper man förmodligen om filen och ger den filändelsen .cel och ger även modellen ett 

lämpligt namn, t.ex. filnamnet Dörrar.cel och modellnamn Enkel dörr 3D. 

När cellen placeras kan man antingen välja en Variation eller redigera variablerna direkt. Endast de 

variabler som har egenskapen Display: Visible kommer att vara synliga och endast de som har Scope: 

Instance kommer kunna redigeras. 
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Även efter placering kan cellen uppdateras från dialogen Properties där man kan ändra Variation eller 

redigera variabler. 

Övning 

Öppna filen Parametrisk modell.dgn. 

Placera cellen Dörr_3D_param. 

Använd variations för att justera storleken.  
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Perforators (Tech preview) 

 

Perforators löser ett stort problem man tidigare har haft när man velat flytta en dörr eller ett fönster 

som placerats i en vägg (solid). När man vill flytta ett fönster måste man manuellt och redigera hålet i 

väggen eftersom dessa inte har någon relation till varandra. I Bentleys byggprogram har detta 

hanterats automatiskt men i ren MicroStation har man behövt hantera detta manuellt. I MicroStation 

CONNECT kan man använda perforators för att lösa detta problem! 

Perforators är en solid som är en del av en cell och som används för att slå hål i den solid som cellen 

placeras i. Elementet som utgör en perforator visas inte när cellen placeras. 

Skapa en Perforator 

Skapa en vanlig 3D-cell i valfritt cellbibliotek. 

 

När cellen är klar är det dags att bestämma hur den ska slå hål på den solid den placeras mot. 

Skapa en solid som motsvarar det område som ska öppnas. Soliden måste vara en parametrisk solid 

så börja med att rita en shape och gör sedan Extrude till önskat djup. 
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Observera att den bara kommer att skapa en öppning som motsvarar denna solid så vill man kunna 

placera fönstret i olika tjocka väggar måste man göra blocket tillräckligt djupt.  Eftersom detta element 

inte syns när cellen placeras gör det inget om det är djupare än de övriga elementen i cellen. Sätt 

gärna en transparens på elementet så blir det lättare att skilja den från cellen i övrigt. 

 

Nu ska vi tala om att vi vill använda detta element som perforator. 

Skriv Perforator i sökfältet och starta kommandot. 

Kontrollera att Hide Perforator… är förbockat och identifiera soliden. 
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Nu är cellen klar att användas. 

Placera cellen i en vägg eller annan solid. Om allt är korrekt kommer det att bli ett hål i väggen. 

Flytta fönstret. Hålet följer med! 

Obs! Man kan inte kopiera en cell med en perforator. Kopian kommer inte att skapa en öppning. 

Placera en ny cell istället. 

Övning 

Öppna filen Parametrisk modell.dgn 

Placera cellerna Dörr_1_perf och Fönster_1_perf i valfri vägg i huset. 
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Named Presentations (Tech preview) 

 

Named Presentations är en funktion gör det möjligt att visa olika element beroende på vilken vy som 

är aktiv. I exemplet nedan visas en dörr som har olika utseende i olika vyer. 

 

Funktionen finns i [[Drawing] > Content > Parametric Components]. 

 

Man använder denna funktion när man skapar en cell. För att detta ska fungera måste cellen vara en 

parametrisk cell. 
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Placement Points 

 

Placement Points kan användas för att ge en cell alternativa placeringspunkter. 

 

Välj ikonen Add Placement Points och metoden Place Associative Point on Element. Ge en 

Datapunkt där den extra placeringspunkten ska vara. Ge punkten ett beskrivande namn. 
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Använda Bing Maps 

Man har länge kunnat använda Bing Maps som bakgrundskarta i sina vyer. Tidigare krävde detta dock 

att man registrerade sig hos Microsoft och använde Raster Manager (vilket man fortfarande kan göra). 

Numera kan man i stället slå på dessa bakgrundskartor med ett klick. 

Välj koordinatsystem 

Innan man kan använda Bing Maps måste man tala om vilket koordinatssystem man arbetar i. Detta 

gör man via dialogen Geographic Coordinat System. Skriv Coord i sökrutan så hittar ni rätt. 

 

Klicka på ikonen From Library. 

 

Då öppnas dialogen Select Geographic Coordinate System. 
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De vanligaste är att man arbetar i något SWEREF-system. Dessa hittar man under Library – Projected 

(northing, easting) – Europe – Sweden – SWEREF1999. I Stockholmstrakten är det SWEREF1999-

18-00 som ska användas. Dubbelklicka på önskat koordinatsystem så stämplas filen och man kan 

använda många användbara funktioner. 

Observera att koordinatsystem inte är nytt för MicroStation CONNECT. 

Slå på Bing Maps 

Nu kan man slå på och av Bing Maps i olika vyer genom att använda ikonen Select Background Map 

från vykommandona (i CONNECT 10 versionerna finns Bing Maps i dialogen View Attributes). 

 

Map Type 

I exemplet används Road  i vy 1 och Aerial i vy 2. 

 

Elevation Offset 

Detta styr på vilken Z-höjd rastrets ansluts i en 3D-fil. 

Transparency 

Detta sätter transparens för rastret. 
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Övning 

Öppna filen Bing Maps.dgn. 

Sätt koordinatsystemet till SWEREF99-18-00. 

Använd dialogen View Attributes för att slå på Bing Maps i vyn. 

 

  



 

  88 GIS (MicroStation 2023)  

 

GIS (MicroStation 2023) 

I MicroStation 2023 finns möjlighet att läsa in data från ett antal GIS-datakällor. 

I Workflow Geospatial Context hittar man verktyg för att läsa in data från olika vektor och 

rastertjänster. 

 

För att kunna göra detta måste det finnas ett koordinatsystem definierat i filen. Detta rekommenderas 

att man alltid gör om man arbetar med geografiska data. 

Bing Maps 

Om man startar Bing Maps från detta workflow öppnas en dialogbox där man kan aktivera bakgrunden 

i flera vyer samtidigt. 

 

Feature Services 

Asdasd 

Raster Services 

asdfasdf 
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Rasterlinjestilar 

Det finns numera möjlighet att skapa och använda linjestilar som baseras på rasterbilder. Det gör att 

man kan skapa i stort sett vilka typer av linjestilar som helst. 

Det följer med ett antal rasterlinjestilar som visar hur dessa kan se ut. 

 

Man väljer rasterlinestil på samma sätt som man väljer vanliga linjestilar genom att sätta aktiv linjestil 

eller ändra i Properties. 
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Area Tools 

 

Area Tools dök upp i Update 17. Det är en samling verktyg för att enkelt placera ut areatexter i 

modellen. Paletten består av några olika verktyg men det viktigaste är ”Measure Area and Place Text”. 

Välj någon av metoderna för att välja yta, klicka och placera sedan texten med önskad Text Style. 

 

Man kan även välja att texten ska placeras som ett Text Field vilket gör att den uppdateras om ytan 
modifieras. 
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Set Element Elevation 

Set Element Elevation är ett verktyg hämtat från MDL-programmet CivTools som finns för 

MicroStation v8i. Detta verktyg gör det enkelt att platta och flytta linjära 3D-element till olika höjder. 

 

Man kan även ange en stegvis ökning (Increment) vilket är smidigt för att lyfta höjdkurvor från 2D till 

3D. 
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Importera PDF som element 

Man kan från och med MicroStation CONNECT Update 17 ansluta och importera PDF-filer som 

vektordata. För att detta ska fungera måste man sätta konfgurationsvariabeln 

MS_IMPORT_USINGADOBEPDF = 0 (default = 1) och sedan starta om MicroStation. 

När detta är gjort kan man använda Attach Reference och Merge Into Master eller Import PDF för att 

få en redigerbar PDF-fil. 

Funktionen är fortfarande lite skakig. Bland annat fungerar den inte om sökvägen innehåller svenska 

tecken. 
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Reality Modeling 

Reality Modeling är ett begrepp som Bentley använder för att beskriva datamodeller som skapats 

genom att fånga in data från omgivningen. Det kan vara foton eller laserskanningar som används för 

att bygga upp en 3D-modell av verkligheten. 

Man har även tidigare kunnat referera in punktmoln och 3D-mesh för presentation eller som 

konstruktionsstöd men MicroStation CONNECT hanterar dessa stora modeller betydligt bättre. 

Context Capture 

Context Capture är den programvara som används för att skapa 3D-mesh från fotografier. Detta är ett 

separat program och kommer inte att beskrivas här. Däremot ska vi titta på hur man kan använda de 

3D-mesh som skapats av Contect Capture i MicroStation CONNECT. 

Koppla filer 

För att koppla upp ett 3D-mesh väljer man Attach Mesh från ribbonmenyn [[Drawing] Attach > Reality 

Mesh]. 

 

Då öppnas följande dialog. 

 

Ange ett filnamn eller en url för att koppla upp 3D-modellen. 
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Nu kan modellen används som stöd vid konstruktion, för presentation, snitt och sektioner. 
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LumenRT 

Visualiseringsprogrammet LumenRT kan installeras i samband med installationen av MicroStation 

CONNECT. Detta är ett fristående program för att skapa olika typer av 3D-visualiseringar. 

En 3D-modell kan exporteras direkt till LumenRT via ikonen LumenRT i Workflow - Visualization. 

 

Modell i MicroStation 
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Modell i LumenRT 

 

Den version av programmet som levereras tillsammans med MicroStation är en något begränsad 

version men den är enkel att använda och man kan komplettera sin modell med många olika typer av 

objekt som träd, fordon och människor och även variera årstider och modellera terräng. 

Övning 

Öppna filen Husmodell 3D.dgn. 

Aktivera den sparade vyn ”Export LumenRT ”i vy 2. 

Starta LumenRT. 
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Övriga förändringar 

 

För en komplett lista över nyheter och förändringar i MicroStation CONNECT öppnar man enklast on-

linehjälpen (F1) och tittar under sektionen What´s New? 

Finns även tillgängligt via on-linedokumentationen. 

Några viktiga nyheter 

Item Types 

Import/Export Item Types 

Expressions in Item Types 

Lumen RT 

Different Display Styles for standard Views 

Rasterlinjestilar 

Labels 

Text Favorites 

Rapporter 

Tabeller 

Sheet Index 

CONNECT Advisor 

Bing Maps i View Attributes 

Vad har tagits bort? 

Vissa funktioner har tagits bort eller dolts eftersom de kommer att ta bort. Här listas några av de 

funktioner som ska undvikas i MicroStation CONNECT. 

Tags (ersätts av Item Types) 

MicroStation BASIC (Visual Basic ska anändas) 

Engineering Links (använd Explorer dialog links) 

Feature Modeling (ersätts av Parametric modeling) 

https://docs.bentley.com/LiveContent/web/MicroStation%20Help-v16/en/suitehelp_topic_list.html

